
CHAPTER-1 – A Machine

Exercises

A. 1. b 2.  b  3.  c 

B. 1. natural  2.  man-made  3.  Machines  4. calculator  5. computer

C. 1. We see trees and birds around.

 2. We see buildings and vehicles around.

 3. A computer never gets tired. A computer never makes mistakes.

Activity Zone

A. Do it yourself.

B. 1. M  2.  N  3.  M  4.  N  5.  M  6.  M

C. 1. Television  2.  Refrigerator  4.  Mixer-juicer  5.  Computer

CHAPTER-2 – Parts of a Computer

Exercises

A. 1. a 2.  c  3.  a 

B. 1. T  2.  T  3.  F  4.  T

C. 1. A monitor displays what we do on the computer.

 2. The fill form of the CPU is Central Processing Unit.

Activity Zone

A. Do it yourself.

B. 1. MONITOR  2.  CPU  3.  KEYBOARD  4.  MOUSE

C. 1. b 2.  a  3.  d  4.  c

CHAPTER-3 – A Good Friend

Exercises
A. 1. good  2.  monitor  3.  can   4.  quickly  5.  chatting
B. 1. monitor  2.  games  3.  colours  4.  watch  5.  sums
C. 1. Minesweeper and Pinball are the two games that we can play on our computer.
 2. (a) We can use a computer to draw and colour.
  (b) We can use a computer to play games.
  (c) We can use a computer to watch movies and cartoons.
Activity Zone

A. 1. 3  2.  5  3.  3  4.  5
B. 1. 95  2.  77  3.  47  4.  42
Test Paper–1
A. 1. CPU  2.  Monitor  3.  Mouse  4.  Keyboard       5.  Refrigerator
B. 1. When you move the mouse, a pointer on the monitor moves in the same direction.
 2. A crane is used to lift and move heavy objects.

 3. A computer can be used by your teacher to teach you.
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 4. A computer has four main parts.

 5. Text is displayed on the Monitor.

C. 1. Washing machine  2.  electronic  3.  mouse   4.  many   5.  play

D. 1. d  2.  a      3.  b  4.  c

E. 1. The uses of a computer as follows :

  (a) It helps to draw and colour.

  (b) It helps to play games.

  (c) It helps to watch movies.

 2. Pressing keys of the keyboard to write is called typing.

 3. Three natural things are bird, animals and plants.

 4. Three man-made things are table, chair and car.

CHAPTER-4 – A Mouse

Exercises

A. 1. c  2.  a   3.  c   4.  a

B. 1. A computer mouse can have two or three buttons.

 2. Dust is harmful for the mouse.

 3. A right handed person places index finger on the left mouse button and middle fingers 
on the right mouse button.

C. 1. There are two or three buttons on a computer mouse.

 2. Mouse pad is a flat seat on which a mouse sits.

 3. A mouse pointer is an arrow sign used to point at thing on the computer monitor.

Activity Zone

A. 1. Right mouse button   2. Scroll bar  3.  Left mouse button

B. 1. 3  2.  5  3.  3  4.  3

C. Do it yourself.

D. Do it yourself.

CHAPTER-5 – Keyboard

Exercises

A. 1. b  2.  a   3.  a   4.  a   5.  b

B. Do it yourself.

C. 1. We type words and sentences using alphabet keys.

 2. The enter key is used to move the cursor to the next line.

 3. The spacebar key is used to leave space between words.

 4. The spacebar key is the longest one on the keyboard.

Activity Zone

A. Alphabet keys  :  6

 Number keys   :  5

B. Do it yourself.
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CHAPTER-6 – Taking Care of a Computer

Exercises

A. 1. special  2.  soft   3.  damage  4.  pad   5.  Do not

B. 1. We should not press the keys of the keyboard hard because it can damage our 
keyboard.

 2.   A computer is a sensitive machine. If we do not take care of it, it can damage.  

 3.   We should not press the keys of the keyboard too hard. We should not eat or drink 
near the computer.

C. 1. clean  2.  mouse  3.  straight  4.  keyboard
Activity Zone
Do it yourself.

CHAPTER-7 – MS-Paint

Exercises
A. 1. b  2.  c   3.  b   4.  c
B. 1. T  2.  T  3.  T  4.  T  5.  F
Activity Zone
A. 1. Ribbon  2.  Drawing Area

Test Paper–2

A. 1. Mouse Pad   2.  Enter Key   3.  Text tool   4.  Pencil tool 

 5.   Scroll Mouse  6.  Three buttoned mouse

B. 1. Escape key   2.  Function keys  3.  Backspace  

 4. Number keys   5.  Alphabet keys   6.  Spacebar

 7. Enter key   8.  Arrow keys

C. 1. Pencil Tool   ;   Pencil tool helps us draw from hand lines on the computer screen.

 2.   Eraser Tool   ;   Eraser tool is used to erase a part or whole of the drawing.

 3. Brushes Tool ; This tool is used to draw lines and curves that have different 
appearance and texture.

D. 1. T  2.  T      3.  F   4.  F  5.  T

E. 1. The scroll wheel helps us to move the pages up and down.

 2. A mouse pad is a piece of rubber on which computer is put.

 3. Enter key is used to begin next line or paragraph.

 4. To save MS Paint file, the steps are as follows.

  (a) Click the File Tab.

  (b) Click Save option. Save As dialog box appears.

  (c) Select the drive and the folder.

  (d) In the file name box, type a name and then click Save button.

 5. The steps to close Paint Window are as follows :

  (a) Click the File tab.

  (b) Click Exit option.
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CHAPTER-1 – Computer–Turn On Switch Off

Exercises
A. 1. c 2.  a  3.  c  4.  a  5.  b 
B. 1. true  2.  true  3.  false  4. true  5. false
C. 1. A desktop is a computer that can be placed on a desk or a table.
 2. Handheld computes are very small computers. We can hold them in our hands and 

work on them.
 3. Two computers that work on batteries are laptop computers and handheld computers.
Activity Zone
A. Do it yourself.
B. Do it yourself.
C. The total number of desktop and 4.
 The number of laptops are 2.
D. Do it yourself.
E. 1. LAPTOP  2.  TABLET   3.  DESKTOP  4.  PALMTOP
F. Do it yourself.

CHAPTER-2 – Parts Of A Computer

Exercises
A. 1. c 2.  b  3.  c  4.  a
B. 1. monitor  2.  CPU  3.  keyboard  4.  printout  5.  microphone
C. 1. The four main parts of a computer are :
  (a) Monitor  (b)  Keyboard  (c)  CPU   (d)  Mouse
 2. A scanner is used to scan (copy) text and images from paper onto the computer.
 3. The full form of UPS is Uninterrupted Power Supply
 4. A CD-ROM stands for Compact Disc Read Only Memory.
Activity Zone
A. 1. PRINTER   2.  SPEAKERS   3.  MICROPHONE
 4. HEADPHONE  5.  SCANNER   6.  CD-ROM
B. 1. b 2.  b  3.  c  4.  type
C. Do it yourself.
Test Paper–1
A. 1. Printer      2.  CD Drive      3.  Microphone      4.  UPS      5.  Scanner      6.  Speakers
B. 1. A laptop requires battery to work.
 2. Super computers are needed for jobs such as space research and weather predication.
 3. A monitor displays words graphs, pictures and movies.
 4. CD-ROM stands for Compact Disc Read Only Memory.
 5. Headphones are used to listen to recorded sound or music without disturbing others.
C. 1. Laptops  2.  battery  3.  Mouse   4.  UPS    5.  Speakers
D. 1. c  2.  b      3.  a  4.  d      5.  e
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E. 1. A computer can work fast without doing any mistake. It can work for hours and never 
gets bored. A man cannot work fast. He sometimes makes mistakes. He sometimes 
gets bored too.

 2. The full form of UPS is Uninterrupted Power Supply.
 3. We can use a computer to listen to music, draw and colour, type, solve sums, send 

mails, watch movies, play games etc.
 4. The steps to turn off a computer are as follows :
  (a) Right click the Start button.
  (b) Click Shut down or sign out.
  (c) Click Shut down.
  (d) The message shutting down will appear. In a few seconds, the monitor turns 

blank, Now, switch off the power button on the monitor.
 5. CPU is a small chip which is fitted inside the CPU cabinet. It is the most important 

part of a computer. It does all that work that you want the computer to do. It controls 
all the other parts of a computer.

CHAPTER-3 – The Mouse

Exercises
A. 1. Mouse  2.  Touch pad  3.  Wireless  4.  Click
B. 1. b  2.  a   3.  c
C. 1. T  2.  T  3.  F  4.  T  5.  F
D. 1. An optical sensor mouse has no ball inside. It detects mouse movement only using an 

optical sensor.
 2. A left click is used to select an item on the computer.
 3. Drag-and-drop is used to move an item from one position to another on the monitor by 

dragging and dropping with the help of a mouse.
Activity Zone
A. 1. c  2.  a   3.  d   4.  b
B. Do it yourself.
C. 1. Trackball  2.  Wheeled mouse  3.  Three-buttoned mouse
 4. Optical Sensor mouse   5.  Wireless-mouse
D.
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CHAPTER-4 – The Keyboard

Exercises

A. 1. b  2.  c   3.  c   4.  a   5.  a
B. 1. T  2.  F  3.  T  4.  T  5.  F
C. 1. Arrow key; This key is used to move the cursor to the right.
 2. Escape key ; The Esc key is used to close a menu or a dialog box.
 3. Shift key ; The shift key is used along with the other key. If we want to type the 

characters marked on the upper part of these keys, we press the shift key along with 
these keys.

 4. Backspace key ; This key helps us to erase mistakes or anything that we do not want 
while typing.

 5. Delete key ; The delete key helps us to delete a character. When pressed erases 
character types on the right side of the cursor.

 6. Caps Lock ; When we press caps lock key, all the letters we type will appear in capital. 
When we press caps lock key again, all the letters we type will appear in small.

 7. Arrow key : This key is used to move upward on document.
D. 1. A cursor is a small blinking live on the monitor. It indicates the place where text will 

appear when we type.
 2. The backspace key erases characters to the left of the cursor. The delete key help us to 

delete a character.
 3. The caps lock key is pressed when we want to type letters in capital.
 4. The Esc key is present on the upper left corner of the keyboard.
E. 1. Shift + Number Key 2.

+_ 2. Symbol Key 
 3. Shift + Number Key 6
 4. Shift + Number Key 7
F. 1. c  2.  d   3.  a   4.  e   5.  b
G. 1. 
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Activity Zone

A. 1. Escape   2.  Function keys  3.  Backspace key 4.  Numeric keyboard

 5. Caps Lock  6.  Spacebar   7.  Enter key   8.  Arrow keys
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CHAPTER-5 – Fun With MS Paint

Exercises

A. 1. a  2.  c   3.  b

B. 1. c  2.  d   3.  e   4.  a   5.  b

C. 1. Shapes tool helps us to draw different types of shapes like rectangles, ellipse triangles 
arrows, hearts, stars, call-outs and many more.

 2. Fill with colour tool helps to fill a selected colour in any closed shapes. It makes your 
drawing colourful.

 3. The magnifier tool helps us to zoom in on a part of your drawing.

Activity Zone

A. Do it yourself.

B. 1. (a) Shapes tool      2. 1. Pencil tool

  (b) Fill with Colour tool     2. Fill With Colour Tool

            3. Colour Picker Tool

Test Paper–2

A. 1. Touch pad       2.  Track ball           3.  Wheeled mouse      
 4.   CD drive        5.  Optical Sensor Mouse        6.  Scanner
B. 1. Fill with Colour Tool helps to fill a selected colour in any closed shape. It makes our 

drawing colourful.
 2. Curve Tool helps us to draw curved lines.
 3. Brush Tool helps us to colour the picture with different text.
 4. Text Tool is used to type anything in the drawing area.
C. 1. T  2.  F  3.  T  4.  T    5.  F
D. 1. Pressing the left mouse button once is called click. Pressing the left mouse button 

twice withing giving any pause is called double click.  
 2.   While typing text, a small blinking line appears on the screen, it is called cursor. A 

cursor marks the place where text would appear when we type.      
 3.   A Shift key is pressed along with the other key. Some keys on the keyboard have two 

characters. If we want to type the characters marks on the upper parts of these keys, 
we press the shift key along with these keys.

 4.   The Num Lock Key should be one if we want to use the numeric keypad on the right 
side of the keyboard.

 5.   To open a new drawing, the steps are as follows.
  (a) Click the File tab.
  (b) Click the New option.
E. 1. Backspace key is used to delete a character on the left of the cursor.
 2. Caps key is pressed when you want to type letters in capital.
 3. Shift key is used when we want to type the characters marked on the upper part of 

some keys.
 4. Up arrow key is used to move the cursor up on the screen.
 5. Escape key is used to close a menu or a dialog box.



CHAPTER-1 – Computer–The Digital Marvel

Exercises
A. 1. a  2.  c   3.  b   4.  a   5.  c 
B. 1. a  2.  d   3.  e   4.  c   5.  b 
C. 1. True  2.  False  3.  False  4.  False  5.  True 
D. 1. We collect carrots, sugar, ghee and khoya. All these things are the inputs for the carrot 

halwa.
  The making of carrot halwa is the processing. The ready to eat carrot halwa in a plate 

is the output.
 2. Hardware refers to the parts of the computer that we can touch and feel. These are the 

physical parts of any computer system. Software is a set of programs or instructions 
given to a computer to perform a task.

 3. Symbol keys on the keyboard are :  ,      ,    , and 

 4. The copy of our work on a memory device is called the soft copy and the copy of work 
on a paper, that is the printout of our work is called the hard copy.

Activity Zone

A. 1. Microphone  2.  Speaker    3.  Monitor  4.  CPU  5.  Printer

 6. Scanner   7.  Keyboard    8.  Mouse  9.  Joystick
B. 
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C. Do it yourself.

CHAPTER-2 – Operating System

Exercises
A. 1. multi  2.  Windows NT   3.  icons   4.  file  5.  taskbar
B. 1. True 2.  True  3.  False  4.  True  5.  True
C. 1. An operating system manages our files. It helps the computer hardware work along 

with other types of computer software. It helps a user work with the computer system.
 2. A single-user operating system allows only one user to work on it at one point of time.
 3. After the welcome message, a screen appears on the monitor. It has a few icons, neatly 

arranged.
 4. The start button is present at the left hand side on the taskbar.
Activity Zone
A. 1. This PC   2.  Network   3.  Recycle Bin  4. Start button
 5.   Taskbar

Input Devices

Scanner

Microphone

Keyboard

Mouse

Output Device

CRT Monitor

Printer

Webcam

LCD Monitor



CHAPTER-3 – More On Paint

Exercises

A. 1. Copy  2.  Rotate  3.  Skew  4.  in

B. 1. The Home tab displays the options for Copy and Paste.

 2.   The steps are as follows.

  (a) Click the Paint button and then point to Set as desktop background.

  (b) Select anyone of the three options :

   Fill, Tile or Centre

 3.   The steps are as follows :

  (a) In order to increase the Zoom level, Click View tab. In the Zoom group, click 
Zoom in.

  (b) In order to reduce the zoom level, click view tab. In the zoom group, click Zoom 
Out.

  (c) If you wish to view the actual picture size, click view. Now, click 100% in the 
zoom group.

Activity Zone

Do it yourself.

Test Paper–1

A. 1. Mouse         2.  Apps window        3.  Recycle bin

 4.   Search charm        3.  Printer      6.  Start Menu

B. 1. A register is a small memory unit in the CPU where all the data to be processed is 
stored.

 2. An operating system operates the computer and allows the computer user to interact 
with its devices.

 3. The taskbar appears at the top of the screen.

 4. The search charm lets you find apps, files or setting on your computer.

 5. Undo and Redo are two buttons that are available on the Quick Access Toolbar of 
Microsoft Word.

C. 1. software  2.  click  3.  processing  4.  icons    5.  search

D. 1. b  2.  e   3.  a   4.  d   5.  c

E. 1. Control Unit controls the movement of information between the registers, the ALU 
and other parts of the computer.

  The ALU unit performs arithmetic operations and logical comparisons.

 2.   A single-user operating system allows only one user to work on it at one point of time. 
A multiuser operating system allows many users to work on it at the same time.

 3.   The steps are as follow.

  (a) Move the mouse pointer to an empty space on the taskbar.

  (b) Right click the taskbar.

2 (Computer Part-3)



  (c) Unlock the taskbar.

  (d) Left click and hold the mouse button.

  (e) Drag the mouse pointer to the right of the computer screen.

  (f) Release the mouse button.

  (g) When you have finished, lock the taskbar by right click on taskbar.

  You will see that the taskbar has shifted to the right hand area of the screen of your 
computer.

 4. The Resize option is used for increasing or decreasing the size of a drawing.

  The skew option is used to Twist the drawing in the horizontal or vertical direction.
CHAPTER-4 – Introduction To Logo

Exercises

A. 1. b  2.  a   3.  a   4.  c

B. 1. Seymour Papert  2.  Turtle  3.  Commander Window

 4.   Graphics Screen  5.  Pause

C. 1. Drawing, writing and doing calculations are three important tasks.

 2. The two uses of LOGO are as follows :

  1.  LOGO helps us to draw pictures.

  2.  LOGO helps us to do calculations. 

 3. MSWLogo screen is divided into two sections– Main screen adn Commander Window.

 4. The other name for Logo Commands is Logo Primitives.

 5. Reset Command is used to clear the Main Screen. Also, the turtle comes to the screen's 
centre.

Activity Zone
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CHAPTER-5 – LOGO Commands

Exercises

A. 1. b  2.  b   3.  c   4.  a   5.  c

B. 1. true  2.  true  3.  true  4.  false  5.  false

Main Screen

Commander Window

Command Input Box

Logo Turtle

Recall List Box

Control Button
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C. 1. If we type the command FD 250, the turtle will move 250 steps forward.

 2. The short form for RIGHT Primitive is RT.

 3. The full form of CS is CLEARSCREEN.

 4. The command is SETPENSIZE.

 5. This command is SETPEN COLOR.

Activity Zone

 1. FD 20  2.  FD 60  3.  RT 50  4.  CLEARTEXT  5.  BK 70

CHAPTER-6 – Introduction To MS Word 2010

Exercises

A. 1. a  2.  c   3.  a   4.  b   5.  b

B. 1. WordPad   2.  Document window   3.  Menu  

 5.   Close   6.  WordPad

C. 1. A word processor is an application software that helps your text on a computer .

 2. Microsoft Word and Word Perfect are two popular Word Processors.

 3. The Title bar displays the document name followed by the program name. There are 
three buttons on the right of the title bar. They are – Minimize, Close and Restore 
Down/Maximum.

 4. Ribbon shows the ‘Tabs’ which show several command groups. Each command group 
has various command buttons. You click on these buttons to issue commands. There is 
a dialog box launcher at the button-right corner of most of the groups.

 5. The steps are as follows :

  (a) Click Start. Start Screen will appear.

  (b) Click on arrow pointing downward to bee all the apps.

  (c) Trace MS Word 2010.

  (d) Click MS Word 2010.

 6. The steps are as follows :

  (a) Click the Fill tab. This takes you to Backstage view.

  (b) Click Save option.

  (c) The Save As dialog box appear.

  (d) Select the desired drive and folder.

  (e) Type the file name in the File name text box.

  (f) Click on Save button.

 7. The steps are as follows :

  (a) Click Start > Click down-pointing arrow on the Start screen > All apps are 
displayed > Go to the end > Select Notepad.

  (b) The Notepad window appears on the screen.
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Activity Zone

A. Do it yourself.

B. 

C.

Minimize
Restore

Close

Dialog box
launcher

File Tab

Ribbon

Quick Access toolbar Title bar

Status bar

Taskbar

Vertical
ruler

Insertion point

Horizontal
ruler

Scroll
box

Vertical
Scroll bar

Document
window
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CHAPTER-7 – Tux Paint

Exercises
A. 1. Color  2.  Help Area   3.  Lines   4.  Shapes  5.  New
B. 1. false   2.  true   3.  true   4.  true   5.  true
C. 1. It contains drawing and editing tools.
 2. The Magic tool helps us to give special effects to a picture.
 3. The open tool is used to load a picture.
Test Paper–2
A. 1. 

Commander
Window

Main Screen

Command
Input Box

Logo Turtle

Control
Buttons

Recall List Box



 2. Minimize

Restore

Dialog box
launcher

Insertion point

Horizontal
ruler

Scroll
box

Document
window

Quick Access toolbar Title bar

Close

Vertical
Scroll bar

File Tab

Ribbon

Vertical
ruler

Status bar

Taskbar

B. 1. add special effects   2.  Command  3.  Commander Window  

 4.   Home     5.  Notepad

C. 1. true  2.  true  3.  true  4.  true    5.  true

D. 1. Type BYE in the input box and press Enter

      or

  Click File Õ Exit

 2. The FORWARD primitive makes the turtle move ahead in the direction that it is 
pointing towards. The BACKWARD primitive makes the turtle move backwards.

 3. CLEAR SCREEN primitive clears the drawing from the Graphics (Main) screen and 
moved the turtle back to its home.

 4. The Lines tool helps us draw straight lines.

 5. The Magic tool helps us add special effects to our drawing.

E. 1. FD 90    2. FD 90

  LT 100     LT 120

  FD 90     FD 90

  LT 100     LT 120

  FD 90     FD 90

  LT 100     LT 120

  FD 90

  LT 100
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CHAPTER-1 – Applications of Computers

Exercises

A. 1. c  2.  b   3.  b   4.  c

B. 1. keeping   2.  medical tests, surgeries   3.  account balance, interest

 4.   bills    5.  desktop publishing    6.  computer

C. 1. It is because of the following reasons :

  (a) It is very fast and accurate.

  (b) It can do several tasks at the same time.

 2.   The uses of computers in banks are as follows :

  (a) Printing customer's account statements

  (b) Updating account balance and calculating interest.

  (c) Online enquiry of customer's account balance

  (d) Operating Autometed Teller Machines which are machines installed outside the 
bank that enable customers to withdraw money at any time.

 3.   Computers are widely used in the field of medicine for the purpose of diagnosis and 
treatment.

 4.   Computer controlled cameras are used in satellites. They help us to know about the 
heavenly bodies and water.

 5.   With the help of computers, it has become easy to make cartoon films and other 
animation. Computers also help to create special scenes like a building on fire, an 
earthquake or a big battle.

Activity Zone

A. 1. School   2.  Office   3.  Bank  4.  Hospital

B. Visual Effects VFX

 Special Effects SFX

 VFX are digital, made on a computer in post production, SFX are practical (props, make-
up, animatronics, pyrotechnical, etc.) made on set during production. You can also mix 
them like shooting a SFX footage and composite it using VFX.)

CHAPTER-2 – Input And Output Devices

Exercises

A. 1. b  2.  a   3.  c   4.  b   5.  a

B. 1. peripherals  2.  control  3.  Joystick  4.  false  5.  hard

C. 1. false  2.  false  3.  true  4.  true  5.  false  6.  true

D. 1. The main function of a mouse is to point things on the monitor and select files, 
folders etc. It also helps to drag an object on the screen from one place to another. It 
also helps to play games on the computer.

 2. The output that you get on a monitor is called the soft copy and the output on a paper 
that we get from a printer is called hard copy.
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 3. The microphone is an input device that converts sound into a signal. This signal then, 
can be feel into a computer speakers produce audible output. You use them to hear 
music or other sounds on your computer.

 4. Magnetic Ink Character Reader is designed to read the numbers present at the bottom 
of a cheque. It is used in banks for reading date from cheques.

 5. CRT monitors are heavy and they take up a lot of desk space. LCD monitors are light 
in terms of weight. They consume less power and take up very little desk space.

Activity Zone

A. 1. Scanner   2.  Printer  3.  Microphone  4. Bar Code Reader

B. 1. scanner   2.  Web camera, cables

 3. A barcode scan is fast and reliable and takes infinitely less time than entering data by 
hand. Barcode eliminates the possibility of human error.

CHAPTER-3 – Window 8.1 : A Wonderful OS

Exercises

A. 1. c  2.  a   3.  b   4.  b   5.  a

B. 1. Computer    2.  This PC   3.  Contents

 4.   Control Panel  5.  System Tray

C. 1. When we boot up the computer system the computer screen changes many times and 
flashes some messages. Finally, a screen appears. This is the first screen of the 
Windows and is called Desktop.

 2. Two icons on the desktop are This PC and Recycle Bin.

 3. File Explorer is a window that allows you to explore and manage files and folders 
within your computer.

 4. Moving a file or a folder means shifting it from its original location (source) to 
another location (destination).

  (a) Click the file or folder that is to be copied.

  (b) Click Home.

  (c) Click Copy if you want to copy. Click Move to if you want to move a file or a 
folder.

  (d) Click the destination folder where the file or folder is to copied or moved.

 5. We can always change the name of a folder or a file. Giving a new name to the file or 
folder is called Renaming a file or folder.

 6. The background image of the desktop is called wallpaper. The image that appears 
when the computer is left idle for a specified time is called screen saver.

Activity Zone

Do it yourself.

CHAPTER-4 – Tux Paint

Exercises

A. 1. Story Board  2.  Alt + S  3.  story board   4.  slide show 5.  Erase
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B. 1. To create a slide show the steps are as follows :

  (a) Click Open. It displays the list of saved pictures.

  (b) Click Slides

  (c) Carefully click all those pictures, one by one, which you want to present in your 
presentation. Each picture that you click will be marked by a number.

  (d) Click the sliding scale to adjust the speed of the slide show, from slowest to 
fastest.

  (e) Click Play to begin the slide show.

 2. We will press Alt + S to mute the sound effects.

 3. The sliding scale next to the Play button is used to adjust the speed of the slide show, 
from slowest to fastest.

Activity Zone

Do it yourself.

Test Paper–1

A. 1. Printer          2.  Mouse         3.  Web Camera

 4.   Graphic tablet         3.  Plotter     6.  Scanner

B. 1. Computers are very useful in banks and schools.

 2. Navigation keys are used for moving through the documents or web pages and editing 
the text.

 3. PDF fill will open in Adobe Reader.

 4. The stamp tool is used in Tux Paint.

 5. Stamp tool is used to paste different images like a tree, a ladybird, a lion, a mouse etc.

C. 1. Sky Drive  2.  File Explorer  3.  Moving  4.  Network

D. 1. c  2.  a   3.  e   4.  b   5.  d

E. 1. The steps are as follows.

  (a) In the right pane of the File Explorer, click the file or folder that is to be renamed.

  (b) Click the Customise Quick Access Toolbar arrow and then Rename.

  (c) Type the new name in the highlighted area and press Enter. You will find that the 
name of the folder has been changed. 

 2.   Devices like the keyboard, mouse, etc. that help you enter your date into the computer 
are called input devices. Devices like the monitor, printer, etc., through which you see 
the output are called output device.

 3.   CRT monitors are heavy and they take up a lot of desk space. LCD monitors are light 
in terms of weight. They consume less power and take up very little desk space.

 4. Icons are small pictures on the desktop. These pictures are followed by their names. 
These pictures represent file, folders, programs software.

 5. To quit from Tux Paint, Click Quit. You will first be asked whether you really want to 
quit. If you choose ‘Yes, I'm done!’ but not saved the current picture, you will be asked 
whether you wish to save it or not.
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CHAPTER-5 – Text Editing In MS Word

Exercises

A. 1. text  2.  blue  3.  word  4.  undo  5.  copy

B. 1. true  2.  false  3.  true  4.  true  5.  false

C. 1. Double-click the selection bar or triple-click anywhere in the paragraph.

 2. To delete a word, we can use a backspace key or a delete key.

 3. The copying means to create a duplicate of the selected text, leaving the original text 
unchanged. Moving text means to shift the text from one place to another. Copying is 
done by cut and copy command. Moving is done by Cut and Paste commands.

 4. Quick Access Toolbar can be seen on the top of the Word Screen. It has tools that are 
frequently used, such as, Save, Undo, Redo, etc. We can customise the Quick Access 
Toolbar.

Activity Zone

 1. Delete  2.  COPY/PASTE   3.  CUT

CHAPTER-6 – Formatting In MS Word

Exercises

A. 1. b  2.  b   3.  a   4.  c

B. 1. Ctrl-I   2.  Bold Italics  3.  Right

 5.   Style   6.  Style

C. 1. Setting that are standard or pre-defined in a software package are called default settings.

 2. Take the following steps.

  (a) Select the text or paragraph.

  (b) In the Paragraph group of Home Tab, click the drop-down arrow of the Border 
button and click Border and Shading.

  (c) Click Borders from the Borders and Shading dialog box.

  (d) Choose the settings of your choice.

 3. Displaying text in a certain way is known as character formatting. It consists of text 
properties–font colour, font size, font type, underline, bold, italics, etc.

 4. The steps are as follows :

  (a) Select the text.

  (b) In the font group of Home, click Font dialog box launcher. The Font dialog box 
appears.

  (c) In the Font style box, select the font style–bold and then underline.

 5. Text is highlighted to make it attractive and important.

Activity Zone

 Manish – Bold      Rajni  – Underline

 Karan – Italics      Jaikaran  – Italics and Underline

 Ali  – Bold      Ishita  – Bold and Underline

 Time – Bold and Italics    Paresh  – Normal
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CHAPTER-7 – MS PowerPoint 2010

Exercises

A. 1. a  2.  c   3.  c   4.  b   5.  F5

B. 1. slide  2.  slide show  3.  a presentation  4.  Quick Access  5.  Slide

C. 1. People in the corporate world can use it to present information about their products or 
company in seminars and meetings.

 2. The steps are as follows.

  (a) From the Home tab, click the bottom half New Slide command to open the menu 
of slide layout option.

  (b) Select a slide of your choice.

  (c) That way new slide will be added to your presentations.

 3. The steps are as follows.

  (a) Click Design.     (b) Click More in the Themes group. 

  (c) Select a theme of our choice.

 4. The steps are as follows.

  (a) Click Insert tab.     (b) Click Picture in the Illustration group.

  (c) The Insert Picture dialog box appears on the screen.

  (d) Locate the picture that is to be inserted.

  (e) Click Insert now.

 5. The default extension of a file in PowerPoint 2010 is apptx.

 6. The two ways are as follows.

  (a) Press F5    (b) Click the Slide Show tab. Click From Beginning.

Activity Zone

Do it yourself.

CHAPTER-8 – More On MS PowerPoint

Exercises

A. 1. a  2.  a   3.  b   4.  c   5.  a

B. 1. true  2.  false  3.  true  4.  false  5.  true

C. 1. There are two things that we should keep in mind while making an effective slide.

! Each slide in the presentation should have short and precise text.

! One slide should discuss only one topic or subtopic.

 2. The steps are as follows.

  (a) Click Insert.

  (b) In the Text group, Click Test Box.

  (c) The mouse pointer changes to +.

  (d) Bring the pointer to the place on the slide where you want to add a text box.

  (e) Click and drag the mouse cursor on the slide so that a text box may be inserted.

  (f) When the text box takes the desired size, release the mouse button.



 3. To reposition a text box, drag the pointer over the border. When the pointer changes, 
click and drag the text box to a new location.

 4. The different change case options are :
  Sentence, Case, Capitalize Each word, Togglecase, Lowercase and Uppercase.
 5. The steps are as follow :
  (a) In the pane on the left, right-click the slide thumbnail that you want to delete.
  (b) Click Delete slide.
Activity Zone
Do it yourself.

CHAPTER-9 – Multimedia

Exercises
A. 1. multimedia      2.  education      3.  memory      4.  sound card      5.  interactive
B. 1. With the help of multimedia, many media forms, such as text, sound, video, animation 

and graphics can be combined.
 2. Multimedia programs are generally used for the following purposes :

! Playing games    ! Playing music and movies
! Educational purpose   ! Giving training to students and workers
! Creating movies, games and advertisements

 3. A multimedia system consists of the following hardware :
! Sound card     ! CD-ROM/DVD ROM drive
! Speakers     ! Microphone

 4. The three games that come free with windows are Microsoft Jigsaw, Cut the Rope and 
Chess.

 5. Some popular online games are Counter Strike, War craft, Street Fighter, Call of Duty, 
Gears of War, Age of Empire, etc.

Activity Zone
Do it yourself.

Test Paper–2
A. 
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Ctrl + B Ctrl + I Ctrl + U

Ctrl + J

Ctrl + X

Ctrl + V

Ctrl + C

Ctrl + Shift + L
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B. 1. Windows Media Player

  (i) Click Start Õ Arrow pointing downwards Õ Go to Windows Media Players.

  (ii) The Windows Media Player Window will open on the computer.

 2. The Game of Chess

  (i) Click Start Õ Arrow pointing downs Õ App scree Õ Chess +

  (ii) Click ‘Click to Start’

  (iii) Choose option either Yes or No to play against computer.

C. 1. F  2.  T  3.  T  4.  F  5.  T

D. 1. Moving   2.  Highlighting   3.  Presentation  

 4.  Bullet   5.  Multimedia

E. 1. d  2.  a   3.  e   4.  b     5.  c

F. 1. Making changes in the document, correcting mistakes, checking spelling and 
grammar, etc. is called editing a document whereas making the document look 
beautiful so that it is understood well is called formatting.

 2. We can start a slide show by pressing F5.

 3. The steps are as follows.

  (a) Click Insert.

  (b) In the Text group, click Text Box.

  (c) The mouse pointer changes to +.

  (d) Bring the pointer to the place on the slide where you want to add a text box.

  (e) Now, click and drag the mouse cursor on the slide so that a text box may be 
inserted.

  (f) When the text box takes the desired size, release the mouse button.

 4. Different change case options are Sentence Case, Capitalize Each Word, Toggle case, 
Lowercase and Uppercase.

 5. Multimedia programs are generally used for the following purposes.

! Playing games 

! Playing music and movies

! Educational purposes  

! Giving training to student and workers 

! Creating movies, game and advertisements



CHAPTER-1 – Evolution Of Computer

Exercises

A. 1. b  2.  a   3.  b   4.  b   5.  b

B. 1. Modern-day   2.  Napier's bones    3.  Calculator

 4.   COBOL and FORTRAN   5.  IBM 360 series and 370 series

C. 1. First-genration computers used vacuum tubes whereas the Second-genertion computers 
used transistors.

  The second generation computers were smaller, faster, cheaper and more efficient than 
the first generation computers.

  The first generation computers used machine language whereas the second generation 
computers used high-level languages such as COBOL and FORTRAN.

 2.   Sir John Napier developed the machine called Napier's bones. This device was called 
Napier's bones because it had numbers carved on bones or on strips of wood. This was 
capable of doing multiplications with repeated additions and divisions with repeated 
subtraction.

 3.   The two machines developed by Charles Babbage were : Difference Engine and 
Analytical Engine.

 4.   The drawbacks of the first generation computer were as follows :

  (a) They were very expensive and slow in speed.

  (b) The power consumption was very high.

  (c) They were very large in size and occupied a lot of space.

 5.   The characteristics of the second generation computers are as follows :

  (a) The programming languages like COBOL and FORTRAN were used in this 
period.

  (b) Some examples of second generation computers are 

   IBM  1620, IBM 7094, CDC 1604, UNIVAC 1108.

  (c) They used transistors in the place of vacuum tubes.

  (d) They were smaller, faster, cheaper and more efficient than the first generation 
computers.

  (e) They included all the components that we associated with modern day 
computers–printer, storage capacity, disk storage, operating system, etc.

 6. The CRAY-1 series is an example of supercomputers.

 7. The main features of modern computers are :

  (a) Amazing speed     (b) cent percent accuracy

  (c) Reliability      (d) huge storage capacity

  (e) Ability to perform a variety of jobs
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Activity Zone

1. Pascaline, Blaise Pascal       2.  Napier's bones, Sir John Naper  

3.  Analytical Engine, Charles Babbage    4.  Mark-I, Howard H. Aiken  

5. UNIVAC I, J Presper Eckert and John Mauchly

CHAPTER-2 – Memory Of A Computer

Exercises

A. 1. d  2.  a   3.  a   4.  a   5.  c   6.  a

B. 1. RAM  2.  bit  3.  ROM   4.  USB   5.  CD-ROM

C. 1. Memory is a digital space in which computers store information and all sets of 
instructions.

 2. A computer works with only two digits–o and 1. The date inputs into the computer are 
first converted into o's and 1s for the computer to understand them. These digits are 
called Binary Digits.

 3. Two types of primary memory are RAM (Random Access Memory) and ROM (Read 
only Memory).

 4. Primary memory of a computer is largely temporary in nature. So, it is important to 
have some other form of memory on which date and programs can be stored 
secondary memory.

 5. A hard disk in metallic disk in a circular shape. It has magnetic material coated on it. 
Several hard disks are assembled together. The resultant unit is called Disk Pack.

 6. Pen drives have become so popular because it is easy-to-use and small enough to be 
carried in a packet.

B. 1. RAM is the computer's working memory. It temporarily stores programs are date that 
are being used at a given time by the user. As soon as the power of the computer is 
switched off, the stored date and instructions disappear from RAM. Secondary 
memory is where programs and date are stored on a long-term basis. It is not directly 
accessibly by the CPU. The secondary memory is non-volatile, i.e., it does not depend 
on power supply.

 2. Megabyte is a smaller unit than gigabyte. A magebyte s equal to 1024 KB and a 
gigabyte is equal to (1024 × 1024) KB.

 3. A hard disk is fixed in the CPU box of the computer. It remains there usually and is 
not used to transport date from one computer to the other. Whereas a CD is a portable 
device. It is generally used to transport date from one computer to other.

Activity Zone

 1. Electrical Erasable Programmable Read Only Memory

 2.   Compact Disk-Read Only Memory

 3.   Digital Versatile Disk

 4. Erasable Programmable Read Only Memory

 5. Read Only Memory
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 6. Programmable Read Only Memory

 7. Random Access Memory

CHAPTER-3 – Formatting In MS Word

Exercises

A. 1. b  2.  a   3.  b   4.  a

B. 1. true   2.  true   3.  true   4.  true

C. 1. By default, on MS word document has one column. But you can have multiple 
columns in a ord document. setting many columns on a page is called column 
formatting.

 2. Making changes to the setting of a page is called page formatting.

 3. Alignment is the manner in which text is placed between the margins of a page.

 4. The steps are as follows :

  (a) Select the text.

  (b) Click Page Layout.

  (c) In the Page Setup group, specify the number of columns by clicking columns.

  (d) You can also click More Columns to get the column dialog box. Here you can 
proceed according to your needs regarding setting of columns.

 5. The steps are as follows "

  (a) Click Page Layout.

  (b) In the Page Setup group, click Page Setup.

  (c) The Page Setup dialog box will appear. Click Layout.

  (d) Click the option you want in the vertical alignment box.

  (e) In the Apply to box, click whole document or select text.

  (f) Click OK.

Activity Zone

 1. This button helps to have landscape orientation, i.e., a printout along the length of the 
paper.

 2. The button marks the end of a page.

 3. This button is used to set te size of paper.

 4. This button helps to have portrait orientation, i.e., a printout along the width of the 
paper.

 5. This button is used to specify our own margin settings.

CHAPTER-4 – MS Word–More Features

Exercises

A. 1. equally      2.  Thesaurus  3.  lowercase    4.  Replace   5.  numbered

B. 1. true       2.  true   3.  false     4.  false   5.  true

C. 1. Green wavy lines in an MS word document indicate grammatical mistakes.
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 2. We should check spelling and grammar of text to make it errors free. Only an error-
free text leaves a good impression on the reader.

 3. The steps are as follows :

  (a) Place the cursor at the location where you want to stat the list.

  (b) Click Home.

  (c) In the Paragraph group, click the down arrow next to the Bullets button.

  (d) The Bullet library appears.

  (e) Select the desired bullet.

 4. The steps are as follows :

  (a) Bring the cursor at the location where the symbol is to appear.

  (b) Click Insert.

  (c) Click Symbol in the Symbols group.

  (d) A list of symbols appears, click the desired symbol.

CHAPTER-5 – Making Table In MS Word

Exercises

A. 1. Can  2.  Insert  3.  Merging  4.  Width  5.  Illustrations

B. 1. A row is the horizontal series of cells in the table. A column is the vertical series of 
cells.

 2.   We can create a table using the following different ways.

  (a) Using Grid

  (b) Using the Insert Table option 

  (c) Using Quick Tables

 3.   The steps are as follows.

  (a) Click the cell, row or column where you want to insert a new blank row or 
column.

  (b) Right click, select Insert from the shortcut menu and then select the appropriate 
option.

 4.   The steps are as follows.

  (a) Select the entire table.

  (b) Click Design in Table tools.

  (c) Click the down arrow of the Borders option in Table Styles group. Then choose 
from the following.

   (i) Click one of the pre-defined border sets. Click Borders and Shading. The 
Borders and Shading dialog box comes on the screen.

   (ii) Click the Borders tab and then choose the options you want.

   (iii) Select a border setting from the setting options.

   (iv) Choose a line style from the style drop-down list.
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 5.   Click the Shading tab in the Borders and Shading dialog box. Select the desired 
shaded colour. If you want to remove shading, click No colour. Then click OK.

 6. The steps are as follows

  (a) Open the document.

  (b) Click Insert and then choose Picture button from Illustrations group.

  (c) Click Pictures in the Library group.

  (d) Double click the folder Pictures in the right pane.

  (e) The picture will be inserted. Set the size of the picture according to your 
requirements.

Activity Zone

Do it yourself.

CHAPTER-6 – Working With Objects In MS Word

Exercises

A. 1. can  2.  a closed  3.  Pattern  4.  shadow  5.  Equation

B. 1. true  2.  true   3.  false   4.  true   5.  true

C. 1. The steps are as follows.

  (a) Click the WordArt object.

  (b) Click Shape Fill in the WordArt Style group.

  (c) Click the colour you want under Theme Colors.

  (d) If you want a colour that in not in Theme Color, click More Fill Colors. The 
Colors dialog box appears. You can click the color that you want from the 
Standard tab or use the custom tab to mix your own colours.

 2. The different fill effects that can be applied to a WordArt object are : No Fill, More Fill 
Colors, Picture, Gradient and Texture.

 3. The steps are as follows :

  (a) Click the Insert tab at the top of the window.

  (b) Click the Shape drop-down menu in the Illustrations section.

  (c) Click the Oval icon in the Basic Shapes group.

  (d) Click the mouse at the desired location in your document. Then drag your mouse 
until the oval is at the desired shape.

  (e) If it is not currently selected, click the Drawing Tools–Format tab at the top of the 
window.

  (f) Click inside the Shape Height field in the Size section of the ribbon at the top of 
the window then enter your desired circle height.

  (g) Click inside the Shape Width field under the Shape Height field, then enter
the same value that you entered in Step 7. Your shape should now be a perfect 
circle.



 4. The steps are as follows.

  (a) Click the position at which you want to insert the Clip Art.

  (b) Click Insert

  (c) Choose Clip Art in the Illustrations group.

  (d) The Clip Art pane appears to be right of the MS Word Window.

Activity Zone

 1. WordArt   2.  Picture  3.  ClipArt  4. Shapes

CHAPTER-7 – More On MS PowerPoint

Exercises

A. 1. a  2.  b   3.  c   4.  b   5.  a

B. 1. slide  2.  two  3.  Slides tab  4.  enlarged  5.  Notes

C. 1. The steps are as follows

  (a) Click File tab. This takes you to Backstage view.

  (b) Click New.

  (c) Select Sample templates under Available Templates and Themes.

  (d) Click the template that you want.

  (e) Click Create.

 2. The two ways to add a new slide in a presentation are : office Themes. Duplicate 
Selected Slides or Reuse Slides.

 3. There are many different ways through which one can view a presentation. There are :

! Normal  ! Slide Sorter  ! Slide Slow

 4. The two places are : schools and business house where we likely to come across 
PowerPoint presentation.

 5. The steps are as follows :

  (a) Click Slide Show on the Ribbon.

  (b) Click the From Beginning button in the Start Slide Show group.

  Your slide show will begin on the screen.

Activity Zone

Do it yourself.

CHAPTER-8 – Internet Operations

Exercises

A. 1. a  2.  a   3.  c

B. 1. The Internet is the way of gathering information and knowledge on a particular topic.

 2. The homepage of a website in the opening page or the main page. It comes on the 
screen every time when we type the URL of a website. It contains introductory 
information about its website. It has links to other pages of that website.

 3. A web browser is a software that allows us to view and explore information on the 
web. Most commonly used web browsers are Internet Explorer and Mozilla Firefox.
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Activity Zone

Do it yourself.

CHAPTER-9 – Algorithms And Flow Charting

Exercises

A. 1. a  2.  c

B. 1. The step-by-step procedure for solving any problem is called Algorithm.

 2. Flow lines are used to show the flow of logic in a flowchart.

 3. There are arrowheads used to indicate the flow of information or sequence of 
events.

 4. Sometimes it is more effective to visualize something graphically that it is to describe 
it will words. That is the essence of what flowcharts do for you. Flowcharts explain a 
process clearly through symbols and text. Moreover, flowcharts give you that gist of 
the process flow in a single glance.

C. 1. flow lines  2.  arrowheads  3.  connection  4.  Oval

Activity Zone

 1.          2.

Test Paper–1

A. 1. c  2.  a   3.  b   4.  a   5.  d

B. 1. textile  2.  red  3.  orientation  4.  view  5.  green

C. 1. false  2.  false  3.  true    4.  false  5.  false

D. 1. Anurag  2.  UNIVAC-I  3.  Disk pack   4.  Print   5.  Ctrl + P

E. 1. The steps are as follows.

  (a) Click the Home.

  (b) In the Paragraph group, click he Paragraph dialog launcher.

  (c) The Paragraph dialog box appears. Click Indents and Spacing.

  (d) Select right alignment from the Alignment drop-down list.

 2.   The steps are as follows :

  (a) Click Page Layout.

  (b) In the Page Setup group, click Margins.

  (c) From the drop-downlist, click the type of margin you want.

Read A, B

Cube = S × S × SSum = A + B

Read S

Print Sum Print Cube

Start Start

Stop Stop
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 3.   The steps are as follows. 

  (a) Click Page Layout.

  (b) In the Page Setup group, click Orientation.

  (c) Click Portrait or Landscape.

 4. The steps are as follows :

  (a) Click the position where you want to insert a page break.

  (b) Click Insert.

  (c) In the Pages group, click Page Break.

 5. The steps are as follows :

  (a) Click Review

  (b) Click Thesaurus button present in the Proofing group.

  (c) The Research task pane appears to the right of the document window.

  (d) Press ALT and click the word that you want to look up. Results appear in the 
Research task pane.

F. 1. The limitations of the 1st Generation computers are as follows :

! Their potential to be programmed for tasks was quite limited.

! Their operating speed was quite slow.

! Their power consumption was very high.

! They required large space for installation.

 2. Artificial Intelligence is a branch of computer Science that aims to create computers 
that can thin, behave and act as humans do.

 3. If power to the computer is turned off, the contents of ROM are not lost. Such memory 
is called non-volatile memory.

 4. Making changes to the setting of a page is called page formatting.

 5. Grammar and spelling check in the MS word document helps in checking 
and correcting the spelling and grammar in the entire document or in a part of a 
document.

G. 1. Ctrl + E

 2. Ctrl + R

 3. Ctrl + L

 4. Ctrl + J

Test Paper–2

A. 1. d  2.  a   3.  e   4.  b     5.  c

B. 1. Format  2.  F5  3.  flow lines   4.  tab    5.  Illustration

C. 1. false  2.  false  3.  true  4.  true  5.  false

D. 1. F5   2.  WordArt   3.  row4.   Parallelogram  5.  Borders
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E. 1. The steps are as follows.

  (a) Select the cells your want to merge.

  (b) Click Layout.

  (c) In the Merge group, click the Merge Cells option.

 2. The steps are as follows.

  (a) Click the column where you want to insert a vew blank column.

  (b) Select Insert from the shortcut menu, and then select the appropriate option.

 3. The steps are as follows :

  (a) Click the Design tab.

  (b) You can choose one of the displayed themes or click more to see more designs.

 4. The steps are as follows :

  (a) Click Insert.

  (b) Click the Table button and then, click Draw Table.

  (c) Click and drag to draw a rectangle in the document.

  (d) Draw horizontal lines to create rows. Draw vertical lines to create columns.

 5. The steps are as follows :

  (a) Click Insert.

  (b) Click Picture in the Illustration group.

  (c) The Insert Picture dialog box open up.

  (d) Locate the picture and then click the Insert button.

F. 1. A collection of inter-linked pages is called a website. A webpage is designed to 
provide information on the Internet. It is a visual part of World Wide Web.

 2. In Slide Sorter view, we can see all the slides in the presentation at the same time, in 
miniature form.

  Slide Show view displays a series of slides one by one in full screen.

 3. We can create a table in MS Word document using a grid by following the given steps :

! Click Insert and Click Table in the Tables group.

! The Insert Table grid appears. Drag the mouse button to highlight the number of 
rows and columns.

! Click the mouse button. An empty table gets inserted in the document.

  We can create a table in MS Word document using the Insert Table option by 
following the given steps.

! Click Insert and then the Table option in Tables groups.

! The Insert Table dialog box appears.

! Specify the number of rows and columns.

! Click OK.
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 4. The step-by-step procedure for solving any problem is called algorithm.

  A diagrammatic representation of the steps for solving a problem is called flowchart.

 5. A row is a horizontal series of cells in the table. A column is the vertical series of cells.

G. 1. We can give shading to a table by following the given steps.

  (a) Select the entire table or the cells.

  (b) Click Design in Table tools.

  (c) Click the down arrow of the Shading option.

  (d) Select the desired shaded colour. If you want to remove shading, click No Color.

 2. The steps are as follows :

  (a) Select the WordArt.

  (b) Click Format.

  (c) Click Edit Text in the Text group.

  (d) The Edit WordArt Text box appears.

  (e) Type the new text and finally click OK.

 3. We can view a slides in a presentation in the following three ways.

  (a) Normal View     (b) Slide Sorter View

  (c) Slide Show View

 4. Three examples of Internet browsers are :

  Internet Explorer, Mozilla Firefox and

 5. In a flowchart, a process is represented by pictorial representation of steps. We use 
different boxes to make a flowchart. They are connected to each other with the help of 
flow lines.
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